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Reports in WEDSS
[bookmark: _Toc456771560]Cumulative Report
This report type provides the number of Disease Incidents by disease name and the number of Outbreaks by ‘Outbreak Type’ (i.e. Diarrhea of the Newborn, Foodborne Disease, Other, and Waterborne Disease).
[bookmark: _Toc456771561]Generating a Cumulative Report
To access the ‘Cumulative Report,’ navigate to the ‘Reports’ menu and then select ‘Cumulative Report.’
[image: ]
You will receive a pop-up window that will prompt you to select your filtering criteria.
[image: ]
First, select the ‘Date Type’ to use.  Select the data for your report between a date range by entering ‘To’ and ‘From’ dates. If you select the ‘Weekly Place of Report Format’ checkbox, the report will use the designated ‘Week Number,’ based on the date entered in the ‘From’ date field.
[image: ]

To include a count of the number of Outbreaks,   select the ‘Include Outbreak/Investigations’ checkbox. This option is not recommended because the grouping is not informative (you cannot group by the disease of the particular outbreak). 
[image: ]

To filter the report by Jurisdiction (labelled ‘Incident Jurisdiction’) or Jurisdiction Group (labelled ‘Grouping’), select the radio button and open the drop-down list.
[image: ]
You can further filter by ‘Resolution Status,’ ‘Process Status,’ and ‘Transmission Status.’ To apply multiple filters for each report, click the ‘Add’ buttons.
[image: ]
To filter by multiple Disease Groups,’ select the Grouping radio button, open the drop-down list, and select ‘Disease Groups’. However, this selection will separate each group into separate sections of the report.  This will limit your ability to easily review each ‘Disease Group’ by the disease count total.
To generate the report, click the ‘Submit’ button and a new tab will open in your browser based upon your selected disease incident criteria.
[image: ]
[bookmark: _Toc456771562]De-Identified Reports
This report type generates an Excel pivot table of the corresponding data generated from your selections. Once in Excel, additional data fields can be selected and added to the pivot table.
[bookmark: _Toc456771563]Generating a De-Identified Report
To access the ‘De-Identified Reports,’ navigate to the ‘Reports’ menu and select ‘De-Identified Reports.’
[image: ]
Upon selecting the ‘De-Identified Reports’ option, the ‘Disease Counts and Incidence Rates – Pivot Table Generator’ screen will appear and will prompt you to set parameters for your report.
[image: ]
The first four options determine the format of your pivot table output. 
[image: ]
To select pre-created columns in your pivot table, use the ‘Select Output Type’ section to enter the following:
· Number of Cases
· One column for number of cases.
· Number of Cases by Jurisdiction
· Multiple columns, one for each Jurisdiction available.
· Number of Cases by Jurisdiction and Process Status
· Multiple columns, with Jurisdictions as subgroups for each Process Status.
· Number of Cases by Jurisdiction and Resolution Status
· Multiple columns, with Jurisdictions as subgroups for each Resolution Status.
NOTE: You can NOT export data related to incidence rates. If you need to create rate based data reports, use Analysis, Visualization, and Reporting (AVR) instead.
To add columns to indicate the month, week, or day (of the month), select the desired option under the ‘Group Output By’ drop down list.
Based on the selections of ‘Select Output Type’ and ‘Group Output By,’ the ‘Title Lines’ will populate with information. That information will appear on the report in a pre-designated format as a Title. You can edit this information or you can choose to wait and edit the final report.
The next set of fields allows you to filter what cases will be displayed in your report.
[image: ]
It is highly recommended that you use the filter and capture only the information you need, rather than exporting all of the available WEDDS data. Filtering will allow you to quickly generate a report in a more useful format.
The final section under ‘Include Fields’ as seen below allows you to select additional information to be included in the final report. The additional selected items will not appear in the pivot table first generated; however, the fields may be used to edit the pivot table after it has been generated or it may be used to create additional pivot tables on your own. 
NOTE: Disease Incident ID numbers are not available in this report.
[image: ]
Once you have selected all of the data fields that you need, click the ‘Generate’ button. After processing, an Excel document will be generated with your designated pivot table.
[image: ]
You are now ready to edit the information in your pivot table and to add fields to specify case counts.  Click on the pivot table you just generated to begin editing. [image: ]
Access the data that is available to be displayed in the pivot table by clicking on the ‘Data’ tab.
[image: ]
[bookmark: _Toc456771564]Epi Curve
This report type generates a line graph of confirmed cases by week for a given ‘Create Year,’ with a baseline calculated from previous years’ data for comparison.
[bookmark: _Toc456771565]Generating a Epi Curve
Access the ‘Epi Curve’ by navigating to the ‘Reports’ menu and select ‘Epi Curve.’
[image: ]
The ‘Epi Curve’ screen allows you to select the ‘Create Year’ for the Disease Incidents that you want graphed. The ‘Epi Curve’ screen also allows you to define the number of years you would like to include in a baseline calculation, which is based on the average number of cases reported during that time frame.
[image: ]
You are also able to filter the cases being displayed by Disease, Jurisdiction, Jurisdiction Group, Region, Zip Code, and Disease Incidents that you as a WEDSS user created. 
When you have selected your criteria, click the ‘Chart’ button and the graph will be generated.
[image: ]
[bookmark: _Toc456771566]Ranged Reports
This report type allows for exports of data contained within an area of a form or for a particular record type within the system. Additional details about each ranged report type are outlined below. 
[bookmark: _Toc456771567]Types of Ranged Reports
· Animal Report Export
· Allows for the export of Animal Report data that is related to the information on the Identification tab.
· Case Report Export
· Allows for the export of data that has been entered into a disease-specific tab or case report. There are options to include the relevant System Sections and the ‘Core Data’ on the relevant System Tabs (e.g. Patient or Investigation tabs).
· This report always exports to the Microsoft Access format.
· Cumulative Disease Report
· Generates a report with identifiable case level data in a preset format.
· Image Export
· Allows for the export of all images that are uploaded into the ‘Filing Cabinet.’
· Incident and Investigation Export
· Allows for the export of Disease Incident and Contact Investigation data that’s related to the information on the Patient tab, Investigation tab, and the System Sections (i.e. Lab, Contact, and Exposure Event widgets).
· Outbreak/Group Event Export
· Allows for the export of Outbreak or Group Event data that’s related to the information on the Outbreak/Investigation or Group Event tab and the System Sections (i.e. Contact and Exposure Event widgets).
· Outbreak by Disease Report
· Generates a report with summary information related to outbreaks in a preset format.
· RVCT exports
· Exports data that has been entered on the selected RVCT tabs.
[bookmark: _Toc456771568]Generating a Ranged Report
You can access ‘Ranged Reports’ by navigating to the ‘Reports’ menu and selecting ‘Ranged Reports.’
[image: ]
Upon, selecting the ‘Ranged Reports’ menu item, you will be prompted to select the type of Report or Export you wish to run on the ‘Ranged Reports’ page
[image: ]
The options for the ‘Select a Report or Export’ will determine the available filtering criteria for your report. To ensure a successful export, select the appropriate parameters to return the data you need. Large date ranges (i.e. multiple years) may take a long time to complete.  To generate a report that requires large date ranges, it is recommended that you use AVR or SSRS.
[image: ]
Once you have selected filters for your report, click the ‘Export’ button.  A pop up window will appear, prompting you to select the file format of the generated report and the fields that will be displayed (i.e. Export Type).  The fields available for your selection depend on the report type selected. Once you have made your selections, click the ‘Export’ button. [image: ]
Note: Any report that contains System Sections, or the Case Report Export, will only export to Microsoft Access.
[bookmark: _Toc456771569]Templates 
To keep the same filtered criteria for future reports, save a Ranged Report as a ‘Template.’ To save an initial template, set your filter criteria and type a descriptive and informative name in the ‘New Template Name.’ To keep the same selected fields and export format saved in your template, check the ‘Include Selected Format’ and/or ‘Include Selected Fields’ check boxes prior to clicking the ‘Save As’ button.
[image: ]
To edit an existing template, select the desired template from the ‘Templates’ drop-down menu and click the ‘Edit’ button.
[image: ]
When you are done making your changes to available filters, click the ‘Save’ button that was previously the ‘Edit’ button.
Note: If you want to make changes to the selected fields or export format, be sure to un-select the two ‘include’ checkboxes, click the ‘Save’ button, and then re-edit the template, selecting the two ‘include’ checkboxes again, before saving a second time. This will then prompt you to select the fields when you generate the report.
[bookmark: _Toc456771570]Real Time Graphs
This report type generates a column chart of the number of cases broken down by Month (of Date Type), Year (of Date Type), Age Group, or Race Group.
[bookmark: _Toc456771571]Generating a Real Time Graph
To access the ‘Real Time Graph,’ navigate to the ‘Reports’ menu and select ‘Real Time Graph.’
[image: ]
Upon selecting the ’Real Time Graph,’ you will be taken to the ‘Real Time Graph Setup’ page   to select the parameters of the graph that will be created 
[image: ]
 ‘Select the Output Type’ drop down option to determine the categories displayed in your column chart.  The categories include:
· Number of Cases by Month (of Date Type)
· Number of Case by Year (of Date Type)
· Number of Cases by Race/Ethnicity (AVR is recommended to access these fields instead)
· Groups are: African American-Black, American Indian-Alaskan Native, Asian-Pacific Islander, Multiple Race, Other, Unknown, and White.
· Number of Cases by Age Group
· Groups are: Infants (0), Toddler (1-2), Preschooler (3-5), Children (6-8), Youth (9-11), Early Adolescence (12-15), Late Adolescence (16-18), Young Adults (19-24), Adult (25-44), Middle Age Adult (45-64), and Elderly (65-120).
NOTE: You can NOT export data related to incidence rates. To create rate based data reports, use AVR.
To filter the data being displayed by Disease, Date, Geographic area (county, jurisdiction, or region), Process Status, and Resolution Status, select your filtering criteria and click the ‘Generate’ button.
[image: ]
[bookmark: _Toc456771572]Analysis, Visualization, and Reporting (AVR)
AVR is accessed at the following website: https://avr.wisconsin.gov.
The login information for the site is your WAMS account information.
If you need access to AVR, contact DHSWEDSS@wi.gov.	 
[bookmark: _Toc456771573]Reports in AVR
There are a number of existing reports that may be helpful to you. In addition, you can make edits to these reports (e.g. filter by jurisdiction or custom date ranges), and save the edited versions in personal folders for future use.
Reports accessed on the WEDSS tab:
 [image: ]
· WEDSS Report - contains five sub reports.
[image: ]
· YTD – Provides Year-To-Date case counts for Confirmed, Closed, and WI cases by disease.  For historical years, the YTD count is the number of cases from January 1st – today’s date in that year.
· Yearly – Provides Yearly case counts for Confirmed, Closed, and WI cases by disease.  For historical years, it will include the full calendar year.
· Weekly – Provides a table and chart of weekly cases counts for WI cases for the past 52 weeks.
· Process Status – Providers case counts for all WI cases by disease and their assigned Process Status.
· Map – Provides a map and table of Confirmed, WI case counts by county.
· WEDSS QA Data – Provides general de-identified information about all Disease Incidents in WEDSS (e.g. ID number, relevant dates, Process Status, Resolution Status).
· WEDSS Incident Creation Report – Provides a chart and table of how Disease Incidents were created in various years. 
· Avian West Nile Virus-Bird Report – Provides a count of reported birds, by type and year, and if they were collected, tested, and result of testing.
· Avian West Nile Virus-Line List – Provides a list of reported birds and their location.
QA Reports accessed in the ‘Web Report Studio’ on the Home tab:
[image: ]
Click on ‘Web Report Studio’ on the Home tab, and this will bring you to the ‘Getting Started’ page. To browse for existing reports, click on either the ‘Open’ link or the ‘More Reports…’ link.
[image: ]
There are many existing reports available that have been created for many different public health prevention and control purposes. The ‘QA’ reports all start with the title ‘Routine QA Reports.’ 
[image: ]
· Routine QA Reports – Contains three sub reports; each are subdivided by jurisdiction.
· Finalized Suspect – Provides a report of all cases that Local Health Departments can set to the ‘Final’ status that have a Process Status of ‘Final’ and Resolution Status of ‘Suspect.’
· County or State missing – Provides two reports; one that is for cases that are missing both State and County information, and one for cases that have WI listed as the State but is missing County information.
· Need finalizing – Provides a report for cases that been created over 60 days ago with a Process Status not equal to ‘Sent to State’ or ‘Final’.
· Routine QA Reports–Finalized suspect - Provides a report of all cases that Local Health Departments can set to the ‘Final’ status that have a Process Status of ‘Final’ and Resolution Status of ‘Suspect’.
· Routine QA Reports–County or state missing - Provides two reports: one for cases that are missing both State and County information, and one for cases that have WI listed as the State but are missing County information. Each report is subdivided by jurisdiction.
· Routine QA Reports–Need finalizing - Provides a report for cases created more than 60 days ago with a Process Status not equal to ‘Sent to State’ or ‘Final’. The report is subdivided by jurisdiction.
· Routine QA Reports–Unknown or blank race ethnicity – Provides a list of ‘Confirmed’ and ‘Probable’ cases that have unknown or blank race or ethnicity data. 
· Routine QA Reports–Weird episode dates – Provides four reports that are subdivided by jurisdiction. 
· Disease reports received in the current year with an ‘Episode Date’ before the previous year.
· Disease reports with an ‘Episode Date’ in the future.
· Disease reports with an ‘Episode Date’ prior to 1993 (not Hepatitis B).
· Hepatitis B reports with an ‘Episode Date’ prior to 1980.
[bookmark: _Toc456771574]Creating New Reports
To create new reports, click on the ‘Web Report Studio’ option on the Home tab.
[image: ]
[bookmark: _Toc456771577][bookmark: _Toc456771575]Creating Reports without the Report Wizard
To create reports from scratch, click on the ‘New’ or ‘New report’ links on the ‘Getting Started’ screen.
[image: ]
To select the data source (i.e. WEDSS_Cube or WEDSS_QA) and data elements that you want to use, navigate to the ‘Data’ menu and select the ‘Select Data…’ option.
[image: ]
A pop up will appear for you to make your data selections. To change your data source, click the ‘Select Data Source…’ button.
· The WEDSS_Cube has data related to case counts, incidence rates, and percentages.
· The WEDSS_QA has de-identified case level data. 
[image: ]
After selecting the data source, select the data items that you want included in your report by highlighting the item in the ‘Available data items:’ area and clicking the single arrow in the middle of the screen. You have all of the items that you need displayed in the ‘Selected data item:’ area, click the ‘OK’ button.
If at a later time you need to add or remove data items to or from your report, re-access the ‘Select Data Item’ area and add/remove additional data items as needed.
[image: ]V
V

The data items selected are displayed on the left hand side of the screen. 
The icons at the top of the screen represent the various ways to display your data. Below are some of the more common report objects used:
· [image: ] Insert list
· [image: ] Insert crosstab
· [image: ] Insert bar chart
· [image: ] Insert line graph
· [image: ] Insert line-bar chart
· [image: ] Insert pie chart
· [image: ] Insert geographical map
· [image: ] Insert text
To add a report object, click on the icons or drag and drop the icon to one of the outlined quadrants under the ‘Header’ section labelled “Drag and drop a report object here.”

[image: ]These icons allow you to format the report area by adding rows, columns, merging and splitting areas, and formatting the alignment of the objects in their area.

To add a report object, click on the icons or drag and drop the icon to one of the outlined quadrants under the ‘Header’ section labelled “Drag and drop a report object here”.
The data items selected are displayed on the left side. 

The icons at the top of the screen represent the various ways to display your data.

Use the icons on the left side to format the report area by adding additional rows, columns, merging and splitting areas, and formatting the alignment of the objects in their area.
[image: ]
To add ‘Group Breaks’ to your report,  click on the ‘Options’ menu item in the ‘Table of Contents’ area and select the ‘Group Breaks…’ item.
[image: ]
A ‘Group Break’ acts similarly to a filter; however, it will create a number of reports, each showing a different value for the data item selected. When viewing the report, you will have the option to select which value you want to ‘Group Break’ by.
[image: ]
Note: It is recommended to have only one ‘Group Break’ in a report. 
Using Templates
You can use a template to pre-set the general layout of a new report. There are a number of pre-made templates or you can create and save your own customized templates.[image: ]

[bookmark: _Toc456771576]Using the Report Wizard
[image: ]
The Report Wizard can be used to assist with the initial creation of a report.
The first screen allows you to select the data that you want in your report.
[image: ]
To select a different data source, click the ‘Select Data Source’ button. The WEDSS_Cube and WEDSS_QA are the most useful for creating reports.
· The WEDSS_Cube has data related to case counts, incidence rates, and percentages.
· The WEDSS_QA has de-identified case level data. 

In the ‘Available data items:’ area you can select various data elements to display or to filter by. To select an item, highlight the item and use the single arrow in the middle of the screen to add it to the ‘Selected data items:’ area.  After you have selected all of the items that you want to use, click the ‘Next’ button twice to go to Step 3 (there is nothing you are able to do in Step 2).
Note: To include additional data elements, select the appropriate ‘Available Data Items’ field.  For instance, to include County Population or County Rate, select County, or to include demographic information, select Age, Sex, Race, and Ethnicity options.
[image: ]
Step 3 allows you to define a ‘Group Break’ with one of your selected data items. A ‘Group Break’ acts similarly to a filter; however, it will create a number of reports, each showing a different value for the data item selected. Typical statewide reports created by WEDSS staff have Jurisdiction set as a ‘Group Break’.  When viewing the report, you will have the option to select the values you want to ‘Group Break’ by.
[image: ]
Note: It is recommended to have only one ‘Group Break’ in a report. 
Once you have selected your option, click the ‘Next’ button.
[image: ] 
Step 4 allows you select options for displaying information in a Table or a Graph. Limited options are available in Step 4, but they can be modified later. When you have finished making your selections, click the ‘Next’ button.
[image: ]
Step 5 allows you to add text to the header and footer of your report. When you have finished entering your desired header/footer text, click the ‘Finish’ button.
[image: ]
AVR will then create the basic elements of the report. You can now further filter and rearrange the data as needed.
[bookmark: _Toc456771578]Editing Reports
To assign content to be presented in your report, right-click on the report object and select the ‘Assign Data…’ option.
[image: ]
A pop up will appear that will prompt you to select the data you want included in your report. The data options available for you to select will depend on the report object that you are using. Below are examples for the crosstab and bar chart. Move the location of the data items by clicking and dragging or by selecting the ‘Move Items’ button. Move items that do you not want displayed to ‘Hidden.’ Once you have moved your items to their desired location, click the ‘OK’ button.
[image: ]     [image: ]

To filter the data, right-click any of the report objects and select ‘Filter and Rank…’  Filters applied to one object will transfer to all of the objects.
[image: ]
A pop up will appear that will prompt you to add filters to each of the available data items. You can only filter the  [image: ] ”category” data items (e.g. Disease) that are not designated as a ‘Group Break’.  You can filter and rank your [image: ] “measures” data items (e.g. Incident count) when viewing the report.
To filter a data item, select the item from the ‘Categories:’ list and select the ‘Filter’ radio button. Select the values listed in the ‘Available values:’ area that you want included and click the arrow button to move them to the ‘Selected values:’ area. 
[image: ]
Once you have applied the desired filters, click the ‘OK’ button.
For crosstab tables, add total and sub-totals for rows and columns by right-clicking on the report object and selecting the ‘Totals…’ option.
You can add text in either the header or the footer to summarize the report. To add text, click on the header or footer and select the ‘Edit…’ option. When you are finished entering the desired text, click the ‘OK’ button.
[bookmark: _Toc456771579]Viewing Reports
To view the report that you compiled, click on the ‘View’ tab.
[image: ]
The report will then be rendered with the information that you selected.
[image: ]
 The ‘Group Break’ option is located in the ‘Table of Contents’ area.
There are a number of format and layout modifications that can be made to the report object: 
· Right-click on a column header to sort, move, or set the alignment for the column
· Right-click on the data to reassign data items, add and remove totals, modify filters, modify ranking, and to rotate the table.
You can only have one filter or rank of a measure per report object. Filtering allows you to display only specific values (e.g. you wish to exclude a disease with a zero incident count). Ranking allows you to display the top or bottom number (or percent) of a given measure (e.g. top ten disease incident counts).
If you do not want to display ‘Applied Filters:’ on the report, go to the ‘View’ menu and un-select ‘Applied Filters.’
[image: ]
You can change the format of various report objects by right-clicking on data in the report and selecting the ‘Properties’ option. This will open a pop-up that will prompt you to adjust the various text and color options.
[image: ]
There are four pre-set styles to choose from in the ‘View’ menu under ‘Report Style.’
[image: ]
[bookmark: _Toc456771580]Saving Reports
To save a report, click on the [image: ] ‘Save’ icon or go to the ‘File’ menu in AVR and select ‘Save’ or ‘Save As.’
Make sure you save the file in the ‘My Folder’ location and use a filename that is descriptive and easily identifiable. Reports saved in your ‘My Folder’ are only accessible by you.
[image: ]
If you want to create a report that others can access and edit, create a folder in the WEDSS\Reports\Workspace folder and save your report there. Again, the name of the folder and the report should be   descriptive and easily identifiable.
[bookmark: _Toc456771581]Exporting Reports
There are two ways to export data from AVR:
1.  To export a single report object, right-click on the object and select the ‘Export Table’ option.[image: ]
This will open a pop up that allows you to export the data in that report object to Excel or Word, or save the data as a TSV or CSV file.
[image: ]
2. If you want to export the entire report, navigate to the ‘File’ menu and select the ‘Export…’ option.
[image: ]
This will open a pop up window which will prompt you to open or save the folder that was generated. Select the ‘Save As’ option and designate a location that you want to save the folder to. The folder is a ‘Compressed Zipped Folder,’ so you will need to right-click on the saved folder and select the ‘Extract All’ option.
[image: ]
A new folder will then be generated. Open the new folder and click on the ‘sasExport’ Excel file inside to open the report.
image3.png
WI Resources

Cumulative Report
Deldentified Reports
EPICurve
Ranged Reports
Real Time Graphs




image4.png
Cumulative Report
Select the appropriate parameters for the Cumulative Report
Warning: This process could take a while with a large date range.
DateType O Create O Onset O Episode @ Closed O Sent O Last Updated
RN —] RS T —
Clweekly Place of Report Format

[Jinclude Outbreak 1 ® Outbreak /Investigation _ Grouping

Investigations Jurisdiction

® ncident surisdiction O Grouping
Y — R — |

[e—— Lhs s

.




image5.png
[Jweekly Piace of Report Format




image6.png
[ include Outbreak /
Investigations




image7.png
@ icisentsusioson O Grovping




image8.png




image9.png
Disease Name Number of Incidents

ARBOVIRAL ILLNESS, WEST NILE 1
VIRUS

ARBOVIRAL ILLNESS, ZIKA VIRUS 13
BLASTOMYCOSIS 1
CAMPYLOBACTERIOSIS 4
CHLAMYDIA TRACHOMATIS 152
INFECTION

CRYPTOSPORIDIOSIS 3




image10.png
Disease Counts & Incidence Rates - Pivot Table Generator

Setect Output Type
TiteLine 1 [
TiteLine2 [ ]

Select the proper parameters for the Report/Export

Warning: This process could take a while with a large date range.

© Disemse) O rowping |
Date Type @ Create O OnsetO) Episode O Closed O Reported
Time rame © Year
O range
Reportmgsowee [ |=®

@© yurisdiction () Grouping |

Region [
res s
[R—

Include Fieids

oate ot girtn Olage Oeender Omaritat status.
Oethnicity Orace oceupation or setting Ociy
Ostate Ozip [loisease being Reported [ oate reatea
[Clate of onset episode pate Cloate of Diagnosis [ pate Closea
[ Ipate Reported OReport source Oaurisdiction DRegion
Olprocess. (] Owen Oiab Report
JenR Report

[ setect 1 unselest An





image11.png
‘Select Output Type
]

Tt Line 1 |

Tite Line2 | ]





image12.png
@ Disease (O Grouping [
Date Type @ Create O) Onset ) Episode O Closed () Reported
Time frame ® Year
O Range
Reporting Source s=
@® Jurisdiction O Grouping |

Region [
Process Status

Resltion staus





image13.png
Include Fields
[ pate of sirth

O ethnicity

[ state

[ pate of onset
[ pate Reported
[process status
[JetR Report

[ select / Unselect All

DOlage

Ozip

[Jepisode bate

[ Report source.
[ Resolution status.

Cleender
[occupation or setting
[loisease being Reported
[pate of Diagnosis

[ ourisdiction

[Clweb Report

[Cmarital status.
Oeity

[oate Createa
[oate closed
[region
[liab Report




image14.png
Number of Cases

1
2 2016
3 Report Created - 5/4/2016
4
5
6
7 Count of Disease being Reported
8 Disease being Reported ~ |Total
9 CHLAMYDIA TRACHOMATIS INFECTION | 9540
10 GONORRHEA 2336

11 Grand Total 11876
12





image15.png
Count of Disease being Reported Gender| -

Disease being Reported - |Female _Male_Unknown (blank)[Grand Total
CHLAMYDIA TRACHOMATIS INFECTION 6468 3063 7 2 9540
GONORRHEA 1153 1182 1 2336
Grand Total 7621 4245 ) 2 11876





image16.png
4 < » » | Ppivot | Data - Range .~ ¥J





image17.png
EPI Curve

Yeartochant 2016 [w]|  Number o histori years o creste baseline

Disease

Restrict By otvame





image18.png
SALMONELLOSIS by Disease \Week for 2015 Baseline 2010-2014 Average

100

—~ 2015
—— 20102014

2





image19.png
Cumulative Report
Deldentified Reports
=

Real 1ime Graphs





image20.png
Ranged Reports

Selecta Report or Export





image21.png
Ranged Reports

Selecta Report or Export

[ineident & nvestston Export

Select the proper parameters for the Report/Export

Warning: This process could take a while with a large date range,
and may time out if the browser limit is exceeded.

O Disease. O Contact Outbreak / Patient Animal
Incidents Investigation  Investigation Record Report

(® Disease O Grouping [
@® Jurisdiction O Grouping [

Region |
Resolution Status [

Tempiates |

Edit Delete [ include Selected Format | | Include Selected Fields

Now Tempiate Name [





image22.png
Instant Export

Grid

[RangedRepot |

- Export Type-

O Comma Delimited Text O Tab Delimited Text O Microsoft Excel O Microsoft Access O XML

[J(Lab Specimen) Collection Date
[ Additional Laboratory
[ additional Provider

O priority A
[process status
[Process Status Administrative Closure Date

[J Address Number & Street [Process Status Asked but Unknown Date

[ Address Standardized [process Status Assigned to DISICDS Date

Oage [erocess Status Closed by LHD-LTBI Date

[J American Indian or Alaska Native - Specify [JProcess Status Closed by State Date

[ Apartment/Unit Number [process Status Closed Date v
L[l Asian Snacifie [Nox Status £ e DISIDHN Data

[ Select / Unselect All [ Al Fields Except System Section Fields [] System Section Fields Only

 Expot | Close




image23.png
[ Edit | [Deiete [linciude Selected Format ¥l include Selected Filds
New Tempiate Name [TestTempate ] saveds





image24.png
‘Templates [TEST TEMPLATE

| Edit  Delete  [Viinclude Selected Format ¥ Include Selected Fields




image25.png
Real Time Graph Setup

Select the Output Type

Select the proper parameters for the Repor/Export
Warning: This process could take a while with a large date range.

@ Disease (O Grouping |
Date Type (@) Create () Onset() Episode () Closed () Reported
oo Tntane Yo
O Range [ ] 7o &

e Gramr
JRe—
Prcess saus





image26.png
Number of Cases

PERTUSSIS (WHOOPING COUGH)
Number of Cases by Month
All Jurisdictions, 2014-2015

S el Sl g4 e A S0 e N e e b s A b S s A Sebi S et s

Month




image27.png
Births and Deaths | WEDSS | Hospitalizations





image28.png
A Table of Contents.

Options +

‘Applied filters: Episode YTD equal to 2007 YTD, 2008 YTD, 2009 YTD, 2010 YTD, 2011 YTD, 2012 YTD, 2013 YTD, 2014 YTD, 2015 YTO
AND State equal to Wi AND Case Closed equal o Yes AND Resoluton Status equa fo Confimed

Incident Count
2007 2008 2009 2010 2011 2012 2013 2014 2015
Y Yy ym

D YD YD ¥ ¥ v v

Disease Group  Disease

o 0 0o 0 o




image29.png
Web Report Studio

ek e to ez cotecton.

3 Web Report studio




image30.png
Getting Started

New report
New using Report Wizard
New using Template ...

HOHON poDooD oD

Avian West Nile Virus - Line List
Avian West Nile Virus - Bird Report

WEDSS Incoming Lab Report

WEDSS Incident Creation Report

WEDSS QA Data -,
'WEDSS STD Performance Report

WEDSS_WN_Virus_Cube
WEDSS QA
WEDSS_Cube
WEDSS_Lab_Cube
WEDSS_STD




image31.png
A Search for files

Search for:

Search what:

Search where:

[Routine QA Reports] x| [ search |
Name Y]
Reports &

=] (515965 [ Show description

Name Actions | Author | Date Path Keywore
/Reports/Workspace/ Tanya's

& Routine QA Reports 5] 21972011 | orts

& Routine QA Reports 5] 2/19/2011 | /Reports

B Routine a4 Report- ] 22212012 | IReports

Finalized suspect

B Routine aa Reports- 5] 22212012 | IReports

county or state missing

B Routine oA Report- ] 22212012 | IReports

Need finalizing

& Routine QA Reports- o 21972017 | /Reports/Workspace/ Tanya's v

Weird episode dates draft reports





image32.png
SAS Web Report Studio - Untitled

File £t View Insert Data 13 (5 [

og Off Christopher Steward rd19@phin) | Preferences | Help:

A Table of Contents

Sectont

A Section Data

Format ...
Preview Section Data

Section Fiters ...
Synchronize Objects

Edit Group Breaks

4ssign Data
Totas ...

Fiter and Rank ...
Conditional Highighting ...

[Jorag and arop a report object here:





image33.png
Selected data items:

(x]

[7) Add new data ftems to existing tables automaticaly.





image34.png
Available data items:

Selected data items:

i Disease Subcategory
SELR Attached

T User Type.

56 Measures

¢ Incident Count.

¢ Contact Count

& Wisconsin Population
& County Population
& Population by Age.
& Population by Sex

& Population by Age and Sex
& Wisconsin Rate

& Rate by Age

& Rate by Sex

& Rate by Age and Sex
& % by Age Group

F Episode Year

F Jurisdiction

) County
SiDisease.
FProcess Status.

S Resolution Status.
& Incident Count.
& County Population





image35.png




image36.png




image37.png




image38.png




image39.png




image40.png




image41.png




image42.png




image43.png
File Edit View Insert Data 2 3 [ Edit

& il = A - A

A Table of Contents  Options +

x
Sectont v |l Header -
i
A Section Data & Options ~
S, =
WEDSS_Cube = [Jorag and drop a report object here
% Episode Year =
 Jurisdiction
T County
B Discase
B Process Status
 Resolution Status o
& Incident Count .
& County Population =
i
4





image44.png
File Edit View lnsert Data 1 (5

A Table of Contents  Options +

Section1 ~

A Section Data & Options ~
WEDSS _Cube

& Episode Year

B Jurisdiction

B County

B Diesse

B Process Status
B Resolution Status
& Incident Count
& County Population
& County Rate

i Episode Year,Incident C

[Graphi

"l

Episode Year Incide ...





image45.png
« 8B

A Table of Contents  Options +

Section

A Section Data &

WEDSS_Cube

§ Episode Year

Insert a New Section ... fle
Delete Section L
Rename Section
Reorder Sections

Group Breaks .

B Jurisdiction





image46.png
 Table of Contents  Options +

al

o Couty
‘Appleton
ot Gty
oot
o Gty
Bayfield County. v
oo Comtr

‘Suspect Vi

A~





image47.png
Step 1 of 5: Select data

Data source: WEDSS_Cube

< Back

k=




image48.png
Selected data items:

56 Measures
¢ Incident Count.
¢ Contact Count
& Wisconsin Population
& County Population
& Population by Age:
& Population by Sex
& Population by Age and Sex
& Wisconsin Rate
& County Rate.
& Rate by Age

oK

cancel

tep





image49.png
Step 3 of 5: (Optional) Create group breaks

Break by: o I
[Junsdiction [V [2INew page for each value [ERRRE
Then by: o
None New page for each value g

None V| [ New page for each value

(o] et [ ] [ conen | [ ]





image50.png
Step 4 of 5: Select a table, graph, or both

Table
Table type: ) it

® Crosstab
Show  Dataitems Bar height:
D toede vemr [incident Count
o County Bars:
@ Disesse [Episode Year ~
[ ProcessStatus
Bar subgroup:
[]  Resolution Status
[None

(e | (oo [t | [ caneet | [ |





image51.png
Step 5 of 5: (Optional) Define the header and footer

Section header

Banner: [T

Text [festRepotHeader

] Display date that query was last refreshed

Section footer

Banner: [T

Text [festRepotFoster

] Display date that query was last refreshed

=

[ Einish_|[ cancet || etp |





image52.png
Episode Year,In

Episode Year,|





image53.png
& Process Status
& County
& Jurisdiction





image54.png
10 Bars (Limit 1)
Episode Year
I Bar Subgroup (Limit 1)
Disease
bHorizonta Series
@ (optional)
182 Vertical Series
@ (optional)
2 Hidden
) County
B Process Status
& Resolution Status
& County Population
& County Rate





image55.png
B assign Data..

@ Total ...
Percentof Total ...

7 Filter and Rank ...
Member Properties .

Episode Year,|

Episode Yeal





image56.png
Category Filters | Measure Filteror Rank |

Type:
O o itr (shaw il values)
® Fiter
Selected values:
2013 A
2014
A 2015
S i
< >





image57.png
5 = Edit View
il = A - A




image58.png
«

Test report

A Table of Contents  Options ~
County.county: [missing]
Applied filters: Episode Year equal to 2013, 2014, 2015 AND Disease equal to CHLAWYDIA TRACHOMATIS INFECTION, GONORRHEA, E-COLI, SHIGA TOXIN-PRODUCING (STEC), SALMONELLOSIS, LYME DISEASE, PERTUSSIS (WHOOPING COUGH),
A N MENNGITDS (ieningococcsl iease) AND Resolsion Status equsi o Confrmed AND Process Status equl o Fins
Adams
pshland Episode Year w1 wia w15 Total
Incident _County  County ncident _County County ncident _County County  Incident County
Barron Count Population Rate Count Population Rate Count Popultion Rate Count Rate
Disease
Bayficld et
Brown TRACHOMATIS
WFECTION 1 18 26 m .
Buffalo v 'GONORRHEA 16 24 19 59 .
Bumett E-COLl, SHIGA
TOKII-PRODUCING
Prme— fons ~ ||| STEC) o o o o .
Sect 00 SALNONELLOSIS o 2 2 ar
LYu Disease ) 2 6 PR
WEDSS_Cube. LYl e
sode Year (WHOOPING
tion . MENINGITIDIS
T County (Meningococcal
B Diesse Discase) o o o 0o .
G Process Status Total 154 L. m L. om Y T
B Resolution Status
& Incident Count Applied ites: Epsode Year qual to 2013, 201, 2015 AND Discase cqua to CHLAKYDIA TRACHONATIS INFECTION, GONORRHEA, E-COLI, SHIGATOXIN PRODUCING (STEC), SALMONELLOSIS, LYME DISEASE, PERTUSSIS (WHOOPING COUGH),N.
& County Populstion WENINGITIDIS (Heningococcal Discase) AND Process Status caual to Final AND Resluton Status equal to Cofirmed
County Rate
L4 v Incident Count.
20

200

180

100

w0

o

Episode Ye 2075 2014 E





image59.png
View Data 13 5

Section 3

¥ Applied Filters
¥ Data Panel

ReportStyle >





image60.png
General 1 Text | Totals |

Cells

‘Sample text

Apply formatting to existing tables in the section





image61.png
View Data [ 5 [ & 1
Section [«

[V Applied Filters s~ | APPl
¥ Data Panel
Lo

ReportStle »| @ plateay
5

WN_Virus_Cube. Meadow
vian Category Festival





image62.png
Mame:  ntors 2012 Couny Ratos and Count

Type: Data i automaticaly refreshed
Location:
[ Caymy Fotcer =] @1 36 [ show description
Name.. sutror oate [ Keyworq *
B ristopher Stewar
= Christopher Steward .
Buffalo,EauClare,Chippewa,Dunn, Pepin CountyRates | (csteward19@phin)
Christopher Stevard
B oun 112312013
2 Hepty couty (csteward19@phin)
Chritopher Stevard
Hep by year Pl 112312013
Chrstopher Stevard
) s et Prfie e Yeor 159 oresent e v |
« i 3
Descriptions: ‘
Keywords: |
(] Automaticaly replace f fle aready evists (] Make read-only





image63.png
LOBACTERIOSIS 091:

percent of Total ...
7 Filter and Rank ...

2] cConditional Highighting ...
[Z Export Table ...

Data Source Details
Properties





image64.png
@Al rows.
ORows.
From: To:
Formatted data Repeat row labels if expanded
©Export to:
Word

Osave as: [Tab separated values (.tsv) file

Comma separated values (.csv) file





image65.png
File Edit View Data 13





image66.png
Extract All...
' Select Left Folder for Compare




image1.png




image2.png
phiin WEDSS




